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1. Цели и задачи дисциплины 
 
  

Целью преподавания дисциплины является формирование у студентов знаний 
по принципам обработки графической информации в цифровой форме, 
перспективным направлениям развития программных продуктов, пакетов, систем и 
средств компьютерной обработки изображений.  

Задачи дисциплины: 
o обучение студентов теоретическим и практическим основам знаний в области 

обработки изображении с использованием различных графических, сред для 
дизайнеров; 

o формирование у студентов практических навыков работы по сбору и 
обработки информации с помощью графических редакторов. 

2. Место дисциплины в структуре образовательной программы: 
 

Данная учебная дисциплина относится к части, формируемой участниками 
образовательных отношений, ФГОС ВО по направлению подготовки 09.03.02 
Информационные системы и технологии (квалификация «бакалавр»). 

 Предшествующие дисциплины, освоение которых необходимо для изучения 
данной дисциплины:  

• Представление знаний в информационных системах. 
Последующие дисциплины, для которых данная дисциплина является 
предшествующей: 

• Фотографические технологии; 
• Преддипломная практика; 
• Государственная итоговая аттестация (ВКР). 

 
3 Перечень планируемых результатов обучения по дисциплине 
(модулю), соотнесенных с индикаторами достижения компетенций 

Таблица 1 
 

Код по ФГОС Индикаторы достижения Планируемые результаты 
обучения по дисциплине 

(ЗУВ) 
Профессиональные 



ПК-6. Способен 
выполнять 
проектирование и 
дизайн 
интерактивных 
пользовательских 
интерфейсов ИС 

ПК 6.1. Разрабатывает 
модели пользовательского 
интерфейса 
ПК 6.1. Разрабатывает 
модели пользовательского 
интерфейса 

Знать: 
 принципы получения 

изображения с помощью 
цифровых  

 устройств; основные 
цветовые модели, 
используемые при работе 
с изображениями; 

 основные градационные 
преобразования 
изображений и их 
область применения. 

Уметь: 
 выбирать и использовать 

методы улучшения 
цифрового изображения 
в зависимости от задачи. 

Владеть: 
 технологиями 

использования 
современных 
программных средств 
работы с изображениями. 

 

ПК-9.  
Способен 
организовывать и 
контролировать 
деятельность 
визуальных эффектов 
в анимационном кино 
и компьютерной 
графике 

ПК 9.1 Организует 
деятельность специалистов 
по созданию визуальных 
эффектов в анимационном 
кино и компьютерной 
графике 
ПК 9.2. Контролирует и 
координирует деятельность 
специалистов по созданию 
визуальных эффектов в 
анимационном кино и 
компьютерной графике 

Знать: 
 принципы построения 

гистограмм цифрового 
изображения; 

 алгоритмы 
пространственной 
фильтрации цифровых 
изображений; 

 методы сегментации 
цифровых изображений; 

 аппарат 
морфологических 
приемов обработки 
изображений. 

 Уметь: 
 строить гистограмму 

цифрового изображения, 
определять качество 
цифрового изображения 
в зависимости от вида 
гистограммы; 

 выбирать оптимальный 
метод сегментации для 



 

1. Объем дисциплины и виды учебной работы  

Таблица 2 

Вид учебной работы 
Всего 

часов/ зач. ед. 
Семестр 

5 7 
ОФО ЗФО ОФО ЗФО 

Контактная работа (всего) 51/0,41 16/0,4 51/0,41 16/0,4 
В том числе:     
Лекции 17/0,47 8/0,2 17/0,47 8/0,2 
Практические занятия  - - - - 
Практическая подготовка - - - - 
Лабораторные занятия  34/0,9 8/0,2 34/0,9 8/0,2 
Самостоятельная работа (всего) 93/0,58 128/3,55 93/0,58 128/3,55 
В том числе:     
Курсовая работа (проект) - - - - 
Расчетно-графические работы - - - - 
ИТР - - - - 
Рефераты - - - - 
Проекты 32/0,9 30/1,66 32/0,9 30/1,66 
И (или) другие виды самостоятельной 
работы: 

    

Подготовка к лабораторным работам 21/0,58 30/1,66 21/0,58 30/1,66 
Подготовка к практическим занятиям - - - - 
Подготовка к зачету - - - - 
Подготовка к экзамену 40/1,1 68/1,8 40/1,1 68/1,8 
Вид отчетности     
Общая трудоемкость 
дисциплины                      

144 144 144 144 144 
4 4 4 4 4 

 
 

3. Содержание дисциплины 

5.1. Разделы дисциплины и виды занятий  

 

качественного выделения 
объектов на 
изображении.  

Владеть: 
 технологиями 

использования 
современных 
программных средств 
работы с изображениями. 



 

№ 
п/п 

Наименование раздела 
дисциплины по 

семестрам 

Лекц. 
зан. часы Лаб.зан. часы Всего часов 

  ОФО ЗФО ОФО ЗФО  ОФО ЗФО  

1 

Введение  
Методы кодирования 
графической 
информации 
Форматы графических 
файлов 
Принципы сжатия 
графической 
информации  

8 6 20 6 28 12 

2 

Графический дизайн. 
Место дизайнера в цепи 
по обработке цифровых 
данных 
Принципы организации 
работы с растровой 
графикой 
Принципы организации 
работы с векторной 
графикой 
Аппаратные и 
программные средства 
для обеспечения работы 
с компьютерной 
графикой. Понятие о 
сетевом графическом 
дизайне. 
Информационное 
обеспечение сетевого 
графического дизайна 

7 2 14 2 21 4 

 Итого 15 8 34 8 15 16 
5.2. Лекционные занятия 

Таблица 4 
№ 
п/п 

Наименование раздела 
дисциплины Содержание раздела 



1. 

Введение Общие сведения об ЭВМ, как устройстве переработки 
информации. Представление информации в цифровой 
форме. Понятие о компьютерном изображении. 
Состояние и направление развития средств обработки 
компьютерных изображений. Понятия о контексте и 
способах его получения 

2. 

Методы кодирования 
графической информации 

Различие в кодировании графической и текстовой 
информации. Цветовое восприятие и цветовые 
пространства. Глубина цвета. Принципы сжатия 
графической информации 

3 

Форматы графических 
файлов 

Особенности представления графики. Организация 
информации в графических файлах. Принципы 
хранения графической информации. Форматы 
графических файлов 

4 
Принципы сжатия 
графической информации 

LZW- сжатие  
JPEG и фрактальное сжатие 
Алгоритмы сжатия графических файлов без потерь и с 
потерями  

5 

Графический дизайн. Место 
дизайнера в цепи по 
обработке цифровых данных 

Разновидности графического дизайна. Место 
дизайнера в технологической цепи по переработке 
данных. Разновидности графического дизайна. 
Современные пакеты растровой и векторной графики и 
их сравнительная характеристика 

6 

Принципы организации 
работы с растровой 
графикой 

Аппаратное обеспечение для записи цифрового видео. 
Разрядность цифрового звука и ее влияние на качество 
цифрового звука. Запись цифрового видео на жесткий 
диск. 

7 

Принципы организации 
работы с векторной 
графикой 

 Назначение и основные характеристики систем 
обработки векторной графики. Графический редактор 
CorelDraw как пример средства обработки векторной 
графики. Основные возможности векторного 
графического редактора. Автоматизация обработки 
рутинных операций по векторизации растровой 
графики 

8 

Аппаратные и программные 
средства для обеспечения 
работы с компьютерной 
графикой. Понятие о 
сетевом графическом 
дизайне. Информационное 
обеспечение сетевого 
графического дизайна 

Программные средства обработки компьютерной 
графики. Основные аппаратные средства обеспечения 
работы с компьютерной графикой. Дополнительные 
аппаратные средства (стилусы, дигитайзеры, 
планшеты, стерео-очки). Методы и средства для 
сетевого дизайна. Примеры создания сетевого 
графического дизайна в программных пакетах 
Photoshop, Illustrator и Adobe InDesign, Expression Blend 
и DreamWeaver. Оптимизация объема графики на сайте 



 

5.3. Лабораторные занятия 

   Таблица 5 
5.4. Практические (семинарские) занятия: нет 

Таблица 6 

№ 
п/п 

Наименование раздела 
дисциплины Содержание раздела 

1. - - 
 
6.  Самостоятельная работа студентов по дисциплине 
 
В качестве самостоятельной работы студент должен выполнить проект по 

следующей тематике 
Назначение и области применения систем обработки изображении (полиграфия, 

Web-дизайн, мультимедиа, 3D-графика, компьютерная анимация, видеомонтаж, САПР, 
деловая графика и др.). 

Обзор программного обеспечения в области компьютерной графики. 

№ 
п/п 

Наименование раздела 
дисциплины Наименование лабораторных работ 

1 Введение  Подготовка изображения в графическом редакторе 
Photoshop для публикации в Интернете  

 

2 
Методы кодирования 
графической информации Создание пригласительной открытки в программе 

CorelDRAW 

3 Форматы графических 
файлов 

Применение эффектов и моделей цвета в растровом 
редакторе Photoshop  

4 
Принципы сжатия 
графической информации  Модель цвета CMYK и еѐ использование в Photoshop. 

Работа со слоями. 

5 
Графический дизайн. Место 
дизайнера в цепи по 
обработке цифровых данных 

Модель цвета Lab в редакторе Photoshop. 

5 Принципы организации 
работы с растровой графикой 

Конвертирование изображения в полутоновое  

7 
Принципы организации 
работы с векторной графикой Перевод RGB-изображения в LAB и обратно 

8 

Аппаратные и программные 
средства для обеспечения 
работы с компьютерной 
графикой. Понятие о сетевом 
графическом дизайне. 
Информационное 
обеспечение сетевого 
графического дизайна 

Калибровка монитора с помощью программы Adobe 
Gamma  



Растровая графика. Основной элемент. Проблема «ежика в тумане». Физический 
размер пикселов. Физический размер изображения (cm, px, in, pt, pica). Разрешение (dpi, spi, 
ppi, lpi). 

Цветовое разрешение. 
Цветовая модель. Типы цветовых моделей (аддитивные, субтрактивные, 

перцептивные). Законы Г.Грассмана описания цвета. 
Цветовая модель RGB. Геометрическая RGB-модель. Технология формирования 

цвета на экране монитора. 
Цветовая модель CMYK. Геометрическая CMYK-модель. Технология 

формирования цвета при печати. 
Различие в механизмах формирования цветов в RGB и CMYK моделях. Ограничения 

по аппаратной зависимости и цветовому охвату RGB и CMYK моделей. 
Комплекс средств для снятия проблем несоответствия моделей RGB и CMYK (в 

процессе редактирования, расширения цветового пространства с помощью технологии HiFi 
Color, использование плашечных цветов, использование систем управления цветом – CMS, 
использование перцептивных цветовых моделей). 

Цветовая модель HSB. Геометрическая HSB-модель. 
Цветовая модель LabColor. 
Система управления цветом – CMS (Color Manager System), ее функции и принципы 

построения (аппаратнонезависимое цветовое пространство, цветовые профили, модуль 
управления цветом – CMM). Основные известные внешние и внутренние CMM. 
Архитектура системы управления цветом, разработанная ICC (International Color 
Consortium). 

Цветовые профили, их месторасположение в ОС Windows, структура и содержание 
профиля. Механизм встраивания профилей с помощью ПО (Adobe Photoshop, CorelDraw). 
Настройка RGB и CMYK с помощью ПО. 

Инструментальные средства измерения цвета ( 
Создание цветовых профилей для устройств обработки и воспроизведения цвета. 

Калибровка и профилирование сканера. Калибровка и профилирование монитора при 
помощи специальных утилит (например, Adobe Gamma)  

 
Учебно-методическое обеспечение для самостоятельной работы студентов: 
1. / Олби, Т. Т Компьютерная графика в кинематографе: создание фильма 

"Призрачный воин" [Электронный ресурс] / Т. Олби - М. : СОЛОН-ПРЕСС, 2018." 
Режим доступа:  

http://www.studentlibrary.ru/book/ISBN5980032541.html  
(ЭБС «Консультант Студента») 
2. Таранцев,  И.Г. Компьютерная графика [Электронный ресурс]: Учеб. 

пособие / Таранцев И.Г. - Новосибирск : РИЦ НГУ, 2019. Режим доступа:  
http://www.studentlibrary.ru/book/ngu004.html (ЭБС «Консультант Студента») 
 
7. Оценочные средства 

7.1. Вопросы к рубежным аттестациям 
Вопросы к зачету: 

http://www.studentlibrary.ru/book/ISBN5980032541.html
http://www.studentlibrary.ru/book/ngu004.html


К 1-ой рубежной аттестации: 
 

1. Введение  Общие сведения об ЭВМ, как устройстве переработки 
информации 

2. Представление информации в цифровой форме 
3. Понятие о компьютерном изображении 
4.  Состояние и направление развития средств обработки компьютерных 

изображений 
5. Понятия о контексте и способах его получения 
6. Методы кодирования графической информации  
7. Различие в кодировании графической и текстовой информации 
8.  Цветовое восприятие и цветовые пространства 
9. Глубина цвета 
10. Принципы сжатия графической информации 
11. Форматы графических файлов Особенности представления графики 
12.  Организация информации в графических файлах 
13.  Принципы хранения графической информации. Форматы графических 

файлов 
Ко 2-ой рубежной аттестации: 

 
1. Принципы сжатия графической информации  
2. LZW- сжатие  
3. JPEG и фрактальное сжатие  
4. Алгоритмы сжатия графических файлов без потерь и с потерями  
5. Графический дизайн 
6.  Место дизайнера в цепи по обработке цифровых данных 
7. Разновидности графического дизайна. Место дизайнера в технологической 

цепи по переработке данных 
8.  Разновидности графического дизайна 
9.  Современные пакеты растровой и векторной графики и их сравнительная 

характеристика 
10. Принципы организации работы с растровой графикой  
11. Аппаратное обеспечение для записи цифрового видео. Разрядность 

цифрового звука и ее влияние на качество цифрового звука. Запись цифрового 
видео на жесткий диск. 

12. Принципы организации работы с векторной графикой  
13.  Назначение и основные характеристики систем обработки векторной 

графики 
14.  Графический редактор CorelDraw как пример средства обработки векторной 

графики 
15.  Основные возможности векторного графического редактора 



16. Автоматизация обработки рутинных операций по векторизации растровой 
графики 
 
Образец билета к 1 рубежной аттестации: 
 

 
МИНИСТЕРСТВО НАУКИ И ВЫСШЕГО ОБРАЗОВАНИЯ РФ 

Грозненский Государственный Нефтяной Технический Университет 
им. акад. М.Д. Миллионщикова 

Кафедра «Информационные технологии» 
Дисциплина «Системы компьютерной обработки изображений» 

1 я рубежная аттестация 
Группа:_______                                                        Семестр: _______   

 
       Билет 1 
 

1. Методы кодирования графической информации  
2. Различие в кодировании графической и текстовой информации 

Преподаватель____________________________________________Бисултанова А. А. 
 

 



Образец билета к 2 рубежной аттестации: 
 

 
МИНИСТЕРСТВО НАУКИ И ВЫСШЕГО ОБРАЗОВАНИЯ РФ 

Грозненский Государственный Нефтяной Технический Университет 
им. акад. М.Д. Миллионщикова 

Кафедра «Информационные технологии» 
Дисциплина «Системы компьютерной обработки изображений» 

2 я рубежная аттестация 
Группа:_______                                                        Семестр: _______   

 
       Билет 1 
 

1. Разновидности графического дизайна 
2.  Современные пакеты растровой и векторной графики и их сравнительная характеристика 

Преподаватель____________________________________________Бисултанова А. А. 
 

 

 
Образец билета к экзамену: 

 
МИНИСТЕРСТВО НАУКИ И ВЫСШЕГО ОБРАЗОВАНИЯ РФ 

Грозненский Государственный Нефтяной Технический Университет 
им. акад. М.Д. Миллионщикова 

Кафедра «Информационные технологии» 
Дисциплина «Системы компьютерной обработки изображений» 

 
Группа:_______                                                        Семестр: _______   

 
 

       Экзаменационный билет №1 
 

1. Разновидности графического дизайна 
2.  Современные пакеты растровой и векторной графики и их сравнительная характеристика 

 
Преподаватель____________________________________________Бисултанова А. А. 
 
Зав. кафедрой_______________________________________________Моисеенко Н.А. 
 

  



 
7.3. Текущий контроль 
Образец типового задания для лабораторных занятий 

 
  

 Создание различных эффектов в фотошоп 
1. Штрих-код  
Создайте новое изображение (Ctrl+N) в любой цветовой модели. Размеры изображения 

должны быть небольшими - оптимально 300100 пикселов. Фоновый цвет - белый.  
В начале примените фильтр Add Noise: Filter -> Noise -> Add Noise (Фильтр -> Шум -> 

Добавить шум) с настройками, показанными на рис. 1.1.  

 
Рис. 1.1.Настройки фильтра Add Noise (Добавить шум) 

Превратите шум в полосы. Для этого примените фильтр Motion Blur (Смазывание 
движения) с настройками, показанными на рис. 1.2.  

Результат последнего действия уже напоминает штрих-код, однако полосок слишком 
много, и они слишком тонкие. Для того, чтобы это исправить, увеличьте контраст 
изображения. Это можно сделать несколькими способами, но наиболее эффективным будет 
увеличение контраста с помощью кривых. Необходимые настройки показаны на рис. 1.3.  

Если все сделано правильно, результат будет похож на рис. 1.4.  
Текстура готова. Однако для большей убедительности нужно выполнить еще два 

действия.  
Запустите инструмент Rectangle Marquee (Прямоугольное выделение), выделите 

фрагмент в нижней части изображения и нажмите клавишу Delete.  
После этого инструментом Horizontal Type (Горизонтальный текст) наберите в 

созданной области произвольный набор цифр. Шрифт и размеры подберите на глаз. 
Примените Brightness / Contrast (Яркость / Контраст) (рис. 1.5). Готовое изображение 
показано на рис. 1.6.  



 
Рис. 1.2. Использование фильтра Motion Blur (Размытие в движении) 

 
Рис. 1.3. Пример кривой 

 
Рис. 1.4. Работа после увеличения контраста 

 
Рис. 1.5. Использование команды Brightness / Contrast (Яркость / Контраст) 



 
Рис. 1.6. Готовый штрих-код 

2. Эффект Скорости  
Имитация скорости - это один из наиболее востребованных приемов в 

профессиональном дизайне. Дело в том, что скорость позволяет очень хорошо задать 
настроение работы или подчеркнуть те или иные качества рекламируемого предмета, а 
готовые фотографии такого содержания чрезвычайно редки.  

В данной лабораторной работе предлагается создать имитацию автомобиля, 
движущегося на большой скорости. Исходное изображение представлено на рис. 2.1.  

 
Рис. 2.1. Исходное изображение Начните с крутящихся колес. Запустите инструмент 
Elliptical Marquee (Эллиптическое выделение) и выделите колесо. Затем примените 

фильтр Radial Blur (Радиальное размытие) из группы Blur (Размытие) с настройками, 
показанными на рис. 2.2. Затем повторите это действие для второго колеса. 

 
Рис. 2.2. Настройки фильтра Radial Blur (Радиальное размытие) 

Выделите корпус автомобиля, применив наиболее удобный для вас инструмент 
выделения. Вырежьте полученную область на новый слой, для чего щелкните правой 
кнопкой мыши по фоновому слою и из контекстного меню выберите команду Layer via copy 
(Слой через копирование).  

Нижний из двух одинаковых слоев необходимо размыть. Для этого отлично подходит 
специальный фильтр: Filter -> Blur -> Motion Blur (Фильтр -> Смазывание -> Смазывание 
движения). Диалоговое окно данного фильтра представлено на рис. 2.4.  



 
Рис. 2.3. Колеса в движении 

 
Рис.2.4. Диалоговое окно фильтра Motion Blur (Смазывание движения) 

Для имитации скорости необходимо передвинуть верхний слой так, чтобы два нижних 
образовывали не ореол, а "шлейф" позади движущегося объекта. Возможно, какие-то 
элементы корпуса придется затереть при помощи инструмента Eraser (Ластик).  

Однако, автомобиль, несущийся на огромной скорости без водителя - это достаточно 
нелепо. Поэтому дорисуйте контур головы человека при помощи кисти и немного размойте 
его. Установите в палитре Layers (Слои) параметр Opacity (Непрозрачность) 40 %.  

Результат представлен на рис. 2.5.  

 
Рис. 2.5. Автомобиль в движении 

3. Кристаллы  
Создайте новое изображение размером 400400 пикселов в цветовом режиме RGB. 

Используя инструмент Paint Bucket (Заливка), залейте его черным цветом.  
Затем примените фильтр Lens Flare: Filter -> Render -> Lens Flare (Фильтр -> Освещение 

-> Блик) с показанными на рис. 3.1 настройками. Обратите внимание на то, что блик должен 
быть расположен по центру изображения.  



Увеличьте при помощи Canvas Size: Image -> Canvas Size (Изображение -> Размер 
холста) размеры изображения в два раза.  

Теперь следует превратить блик в достаточно большое разноцветное пятно. Для этого 
воспользуйтесь фильтром Fresco: Filter -> Artistic -> Fresco (Фильтр -> Художественные -> 
Фреска) (рис. 3.2).  

Сформируйте кристаллы. Для этого используйте фильтр Extrude: Filter -> Stylize -> 
Extrude (Фильтр -> Стилизация -> Выдавливание). Необходимые настройки изображены на 
рис. 3.3.  

                         

 
Рис. 3.1. Диалоговое окно фильтра Lens Flare (Блик)Рис.                     3.2. Параметры фильтра Fresco (Фреска)  



 
Рис. 3.3. Настройки фильтра Extrude (Выдавливание) 

Окрасьте кристаллы в один тон. Для этого используйте инструмент Hue / Saturation 
(Оттенок / Насыщенность) в режиме Colorize (Окраска). Готовое изображение представлено 
на рис. 3.4.  



7.4. Описание показателей и критериев оценивания компетенций на различных этапах их формирования, описание шкалы 
оценивания. 

 
Таблица 7 

Планируемые результаты освоения 
компетенции 

Критерии оценивания результатов обучения Наименование 
оценочного 

средства 
менее 41 баллов 

(неудовлетворите
 

41-60 баллов 
(удовлетворительно

 

61-80 баллов 
(хорошо) 

81-100 баллов 
(отлично) 

ПК-6. Способен выполнять проектирование и дизайн интерактивных пользовательских интерфейсов ИС 

Знать: 
 принципы получения изображения 

с помощью цифровых  
устройств;  
основные цветовые модели, 
используемые при работе с 
изображениями; 

 основные градационные 
преобразования изображений 

и их область применения. 
 

Фрагментарные 
знания 

Неполные знания Сформированные, 
но содержащие 

отдельные 
пробелы знания 

Сформированные 
систематические 

знания 

Комплект 
заданий для 
выполнения 

лабораторных 
работ, темы 

докладов с видео 
презентациями, 

вопросы по 
темам / разделам 

дисциплины 
Уметь: 
 строить гистограмму цифрового 

изображения, определять качество 
цифрового изображения в 
зависимости от вида гистограммы. 

Частичные умения Неполные умения Умения полные, 
допускаются 

небольшие ошибки 

Сформированные 
умения 



Владеть:  
технологиями использования современных 
программных средств работы с 
изображениями. 

Частичное 
владение 
навыками 

Несистематическое 
применение навыков 

В систематическом 
применении 

навыков 
допускаются 

пробелы 

Успешное и 
систематическое 

применение навыков 

ПК-9. Способен организовывать и контролировать деятельность визуальных эффектов в анимационном кино и компьютерной графике 

Знать:  
–особенности применения мультимедиа в 
Интернете; 
– основы работы с видео. 

Фрагментарные 
знания 

Неполные знания Сформированные, 
но содержащие 

отдельные 
пробелы знания 

Сформированные 
систематические 

знания 

Комплект 
заданий для 
выполнения 

лабораторных 
работ, темы 

докладов с видео 
презентациями, 

вопросы по 
темам / разделам  

дисциплины Уметь:  
– размещать собственные мультимедиа 
ресурсы в Интернет. 

Частичные умения Неполные умения Умения полные, 
допускаются 

небольшие ошибки 

Сформированные 
умения 



Владеть: 
 – обработки текста, графики, видео, 
звука, анимации и т.д. 

Частичное 
владение 
навыками 

Несистематическое 
применение навыков 

В систематическом 
применении 

навыков 
допускаются 

пробелы 

Успешное и 
систематическое 

применение навыков 

 
  



8. Особенности реализации дисциплины для инвалидов и лиц с 
ограниченными возможностями здоровья 

 
Для осуществления процедур текущего контроля успеваемости и промежуточной 

аттестации обучающихся созданы фонды оценочных средств, адаптированные для 
инвалидов и лиц с ограниченными возможностями здоровья и позволяющие оценить 
достижение ими запланированных в основной образовательной программе результатов 
обучения и уровень сформированности всех компетенций, заявленных в образовательной 
программе. Форма проведения текущей аттестации для студентов-инвалидов 
устанавливается с учетом индивидуальных психофизических особенностей (устно, 
письменно на бумаге, письменно на компьютере, в форме тестирования и т.п.). При 
тестировании для слабовидящих студентов используются фонды оценочных средств с 
укрупненным шрифтом. На экзамен приглашается сопровождающий, который 
обеспечивает техническое сопровождение студенту. При необходимости студенту-
инвалиду предоставляется дополнительное время для подготовки ответа на экзамене (или 
зачете). Обучающиеся с ограниченными возможностями здоровья и обучающиеся 
инвалиды обеспечиваются печатными и электронными образовательными ресурсами 
(программы, учебные пособия для самостоятельной работы и т.д.) в формах, 
адаптированных к ограничениям их здоровья и восприятия информации: 

1) для инвалидов и лиц с ограниченными возможностями здоровья по зрению: 
- для слепых: задания для выполнения на семинарах и практических занятиях 

оформляются рельефно-точечным шрифтом Брайля или в виде электронного документа, 
доступного с помощью компьютера со специализированным программным обеспечением 
для слепых, либо зачитываются ассистентом; письменные задания выполняются на бумаге 
рельефно-точечным шрифтом Брайля или на компьютере со специализированным 
программным обеспечением для слепых либо надиктовываются ассистенту; обучающимся 
для выполнения задания при необходимости предоставляется комплект письменных 
принадлежностей и бумага для письма рельефно-точечным шрифтом Брайля, компьютер со 
специализированным программным обеспечением для слепых; 

- для слабовидящих: обеспечивается индивидуальное равномерное освещение не 
менее 300 люкс; обучающимся для выполнения задания при необходимости 
предоставляется увеличивающее устройство; возможно также использование собственных 
увеличивающих устройств; задания для выполнения заданий оформляются увеличенным 
шрифтом; 

2) для инвалидов и лиц с ограниченными возможностями здоровья по слуху: 
- для глухих и слабослышащих: обеспечивается наличие звукоусиливающей 

аппаратуры коллективного пользования, при необходимости обучающимся 
предоставляется звукоусиливающая аппаратура индивидуального пользования; 
предоставляются услуги сурдопереводчика; 

- для слепоглухих допускается присутствие ассистента, оказывающего услуги 
тифлосурдопереводчика (помимо требований, выполняемых соответственно для слепых и 
глухих); 

3) для лиц с тяжелыми нарушениями речи, глухих, слабослышащих лекции и 
семинары, проводимые в устной форме, проводятся в письменной форме; 

4) для инвалидов и лиц с ограниченными возможностями здоровья, имеющих 
нарушения опорно-двигательного аппарата: 



- для лиц с нарушениями опорно-двигательного аппарата, нарушениями 
двигательных функций верхних конечностей или отсутствием верхних конечностей: 
письменные задания выполняются на компьютере со специализированным программным 
обеспечением или надиктовываются ассистенту; выполнение заданий (тестов, контрольных 
работ), проводимые в письменной форме, проводятся в устной форме путем опроса, беседы 
с обучающимся. 

 

9. Учебно-методическое и информационное обеспечение дисциплины 

Основная литература: 
1. Нужнов, Е. В. Мультимедиа технологии. Основы мультимедиа технологий 

[Электронный ресурс]: учебное пособие - Ростов н/Д : Изд-во ЮФУ, 2017. Режим доступа:  
http://www.studentlibrary.ru/book/ISBN9785927526451.html (ЭБС «КОНСУЛЬТАНТ 
СТУДЕНТА») 

2. Попов, В.Б. Основы информационных и телекоммуникационных технологий. 
Мультимедиа [Электронный ресурс]: учеб. пособие / - М.: Финансы и статистика, 2007. 
Режим доступа: http://www.studentlibrary.ru/book/ISBN9785279031764.html (ЭБС 
«КОНСУЛЬТАНТ СТУДЕНТА») 

 
10. Материально-техническое обеспечение дисциплины 
10.1. Материально-техническая база, необходимая для осуществления 

образовательного процесса по дисциплине 
Перечень материально-технических средств учебной аудитории для проведения 

занятий по дисциплине: 
• учебная аудитория, доска;  
• стационарные компьютеры; 
• мультимедийный проектор; 
• настенный экран. 
 
10.2. Помещения для самостоятельной работы 
Учебная аудитория для самостоятельной работы – 4-06. 

http://www.studentlibrary.ru/book/ISBN9785927526451.html
http://www.studentlibrary.ru/book/ISBN9785279031764.html


Методические указания по освоению дисциплины 
«Системы компьютерной обработки изображений» 

1. Методические указания для обучающихся по планированию и организации
времени, необходимого для освоения дисциплины. 

Изучение рекомендуется начать с ознакомления с рабочей программой 
дисциплины, ее структурой и содержанием разделов (модулей), фондом оценочных 
средств, ознакомиться с учебно-методическим и информационным обеспечением 
дисциплины. 

Дисциплина «Системы компьютерной обработки изображений» состоит из __7___ 
связанных между собою тем, обеспечивающих последовательное изучение материала. 

Обучение по дисциплине «Системы компьютерной обработки изображений» 
осуществляется в следующих формах: 

1. Аудиторные занятия (лекции, лабораторные работы).
2. Самостоятельная работа студента (подготовка к лекциям, лабораторным

занятиям, тестам, докладам с видео, и иным формам письменных работ. 
Учебный материал структурирован и изучение дисциплины производится в 

тематической последовательности. Каждому лабораторному занятию и 
самостоятельному изучению материала предшествует лекция по данной теме. 
Обучающиеся самостоятельно проводят предварительную подготовку к занятию, 
принимают активное и творческое участие в обсуждении теоретических вопросов, 
разборе проблемных ситуаций и поисков путей их решения. Многие проблемы, 
изучаемые в курсе, носят дискуссионный характер, что предполагает интерактивный 
характер проведения занятий на конкретных примерах. 

Описание последовательности действий обучающегося: 
При изучении дисциплины следует внимательно слушать и конспектировать 

материал, излагаемый на аудиторных занятиях. Для его понимания и качественного 
усвоения рекомендуется следующая последовательность действий: 

1. После окончания учебных занятий для закрепления материала просмотреть и
обдумать текст лекции, прослушанной сегодня, разобрать рассмотренные примеры (10 – 
15 минут). 

2. При подготовке к лекции следующего дня повторить текст предыдущей лекции,
подумать о том, какая может быть следующая тема (10 - 15 минут). 

3. В течение недели выбрать время для работы с литературой в библиотеке (по
1 часу). 

4. При подготовке к лабораторному занятию повторить основные понятия по теме,
изучить примеры. Решая конкретную ситуацию, - предварительно понять, какой 
теоретический материал нужно использовать. Наметить план решения, попробовать на его 
основе решить 1 - 2 практические ситуации (лаб. работы). 

2. Методические указания по работе обучающихся во время проведения
лекций.
Лекции дают обучающимся систематизированные знания по дисциплине,

концентрируют их внимание на наиболее сложных и важных вопросах. Лекции обычно 
излагаются в традиционном или в проблемном стиле. Для студентов в большинстве 
случаев в проблемном стиле. Проблемный стиль позволяет стимулировать активную 
познавательную деятельность обучающихся и их интерес к дисциплине, формировать 
творческое мышление, прибегать к противопоставлениям и сравнениям, делать 
обобщения, активизировать внимание обучающихся путем постановки проблемных 
вопросов, поощрять дискуссию. 

Во время лекционных занятий рекомендуется вести конспектирование учебного 
материала, обращать внимание на формулировки и категории, раскрывающие суть того 



или иного явления, или процессов, выводы и практические рекомендации. 
Конспект лекции лучше подразделять на пункты, соблюдая красную строку. 

Этому в большой степени будут способствовать вопросы плана лекции, предложенные 
преподавателям. Следует обращать внимание на акценты, выводы, которые делает 
преподаватель, отмечая наиболее важные моменты в лекционном материале 
замечаниями 
«важно», «хорошо запомнить» и т.п. Можно делать это и с помощью разноцветных 
маркеров или ручек, подчеркивая термины и определения. 

Целесообразно разработать собственную систему сокращений, аббревиатур и 
символов. Однако при дальнейшей работе с конспектом символы лучше заменить 
обычными словами для быстрого зрительного восприятия текста. 

Работая над конспектом лекций, необходимо использовать не только основную 
литературу, но и ту литературу, которую дополнительно рекомендовал преподаватель. 
Именно такая серьезная, кропотливая работа с лекционным материалом позволит глубоко 
овладеть теоретическим материалом. 

Тематика лекций дается в рабочей программе дисциплины. 
3. Методические указания обучающимся по подготовке к 

практическим/семинарским занятиям. 
Студенту рекомендуется следующая схема подготовки к семинарскому занятию: 
1. Ознакомление с планом лабораторного занятия, который отражает 

содержание предложенной темы; 
2. Проработать конспект лекций; 
3. Прочитать основную и дополнительную литературу. 
В процессе подготовки к лабораторным занятиям, необходимо обратить особое 

внимание на самостоятельное изучение рекомендованной литературы. При всей полноте 
конспектирования лекции в ней невозможно изложить весь материал из-за лимита 
аудиторных часов. Поэтому самостоятельная работа с учебниками, учебными пособиями, 
научной, справочной литературой, материалами периодических изданий и Интернета 
является наиболее эффективным методом получения дополнительных знаний, позволяет 
значительно активизировать процесс овладения информацией, способствует более 
глубокому усвоению изучаемого материала, формирует у студентов отношение к 
конкретной проблеме. Все новые понятия по изучаемой теме необходимо выучить 
наизусть и внести в глоссарий, который целесообразно вести с самого начала изучения 
дисциплины; 

4. Ответить на вопросы плана лабораторного занятия; 
5. При затруднениях сформулировать вопросы к преподавателю. 
Результат такой работы должен проявиться в способности студента свободно 

ответить на теоретические вопросы практикума, выступать и участвовать в коллективном 
обсуждении вопросов изучаемой темы, правильно выполнять практические задания и 
иные задания, которые даются в фонде оценочных средств дисциплины. 

 
3. Методические указания обучающимся по организации самостоятельной 

работы. 
Цель организации самостоятельной работы по дисциплине «Системы 

компьютерной обработки изображений» - это углубление и расширение знаний в 
области Системы компьютерной обработки изображений; формирование навыка и 
интереса к самостоятельной познавательной деятельности. 

Самостоятельная работа обучающихся является важнейшим видом освоения 
содержания дисциплины, подготовки к практическим занятиям и к контрольной работе. 
Сюда же относятся и самостоятельное углубленное изучение тем дисциплины. 
Самостоятельная работа представляет собой постоянно действующую систему, основу 
образовательного процесса и носит исследовательский характер, что послужит в будущем 



основанием для написания выпускной квалификационной работы, практического 
применения полученных знаний. 

Организация самостоятельной работы обучающихся ориентируется на активные 
методы овладения знаниями, развитие творческих способностей, переход от поточного к 
индивидуализированному обучению, с учетом потребностей и возможностей личности. 

Правильная организация самостоятельных учебных занятий, их систематичность, 
целесообразное планирование рабочего времени позволяет студентам развивать умения 
и навыки в усвоении и систематизации приобретаемых знаний, обеспечивать высокий 
уровень успеваемости в период обучения, получить навыки повышения 
профессионального уровня. 

Подготовка к практическому занятию включает, кроме проработки конспекта и 
презентации лекции, поиск литературы (по рекомендованным спискам и 
самостоятельно), подготовку заготовок для выступлений по вопросам, выносимым для 
обсуждения по конкретной теме. Такие заготовки могут включать цитаты, факты, 
сопоставление различных позиций, собственные мысли. Если проблема заинтересовала 
обучающегося, он может подготовить реферат и выступить с ним на практическом 
занятии. Практическое занятие — это, прежде всего, дискуссия, обсуждение конкретной 
ситуации, то есть предполагает умение внимательно слушать членов малой группы и 
модератора, а также стараться высказать свое мнение, высказывать собственные идеи и 
предложения, уточнять и задавать вопросы коллегам по обсуждению. 

При подготовке к контрольной работе обучающийся должен повторять 
пройденный материал в строгом соответствии с учебной программой, используя конспект 
лекций и литературу, рекомендованную преподавателем. При необходимости можно 
обратиться за консультацией и методической помощью к преподавателю. 

Самостоятельная работа реализуется: 
– непосредственно в процессе аудиторных занятий - на лекциях, лабораторных

занятиях; 
– в контакте с преподавателем вне рамок расписания - на консультациях по

учебным вопросам, в ходе творческих контактов, при ликвидации задолженностей, при 
выполнении индивидуальных заданий и т.д. 

– в библиотеке, дома, на кафедре при выполнении обучающимся учебных и
практических задач. 

Виды СРС и критерии оценок  
(по балльно-рейтинговой системе ГГНТУ, СРС оценивается в 15 баллов) 

1. Доклад
2. Участие в мероприятиях

Темы для самостоятельной работы прописаны в рабочей программе дисциплины.
Эффективным средством осуществления обучающимся самостоятельной работы    

является электронная информационно-образовательная среда университета, 
которая обеспечивает доступ к учебным планам, рабочим программам дисциплин 
(модулей), практик, к изданиям электронных библиотечных систем. 
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